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Frequently Asked Questions 
 
Subscription Management 

Words 
Licenses 
Account 
GeoWorkz Directory 

Job Posting 
Connecting to the Translation Workspace Server 
Translation Workspace Web Interface 

User Management 
Asset Management 

 Sharing Linguistic Assets 
Translation Workspace Clients 
 XLIFF Editor 
 Microsoft Word Plug-in 

Online Review Client 
 Translation Workspace Tools 
Translating 
 Supported Formats 
 Best Practices 
 Chat Functionality 

Match Rates 
 Context Matching 
 Fuzzy Matches in an Empty TM 
Interoperability 

When creating a Translation Memory (TM) from non-Translation Workspace legacy data, is it better 
to use a TM export or to use bilingual files to populate the TM? 
 

Subscription Management 

Words 

How do I track my word usage? 

You can view the amount of words remaining for your tenancy in the current billing period by logging in to 
GeoWorkz.com and clicking on the Translation Workspace button. The number of words remaining is 
displayed in the Subscription Usage section. This display is updated every night. 

How does word metering work? 

The words balance in a tenancy is consumed as content is translated using TMs owned by the subscriber. 

Translation Workspace reports the tenancy’s daily word usage. When the subscriber’s TMs are queried 
during translation, words are debited from the purchased words balance. If the TM is made available to 
users outside the tenancy by issuing an Asset Alias token, the queries made by those users are debited 
from the original TM owner’s purchased word balance. Users are not charged for work they do using TMs 
owned and aliased to them by other tenancies. 
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How are words counted for Analysis Reports in Chinese, Japanese, Korean, and 

Thai? 

For Chinese, Japanese, Korean, and Thai, Translation Workspace counts all characters, both ideographic 
and non-ideographic characters, as well as punctuation but not white spaces. The counting technique used 
is determined from the language setting of the source content. 

How does word metering work for Chinese, Japanese, Korean, and Thai? 

Translation Workspace programmatically applies a ratio to system-generated character counts before 
passing information to the metering engine used for word usage charges. The word usage shown in the 
Translation Workspace section of GeoWorkz.com will therefore have already been adjusted downward for 
Chinese, Japanese, Korean, and Thai. 

 
These per language ratios are as follows: 
 
 Chinese (Simplified): 2.8 characters to one word 
 Chinese (Traditional): 2.8 characters to one word 
 Japanese: 3 characters to one word 

 Korean: 3.3 characters to one word 
 Thai: 6 characters to one word 

What if I need more words than available in my subscription this month? 

After more words have been translated in the tenancy than your plan allows for, the tenancy will be billed 
for "overage." Every plan has a pay-as-you-go option for additional words above the base allocation (this 
is called ―overage‖). If additional words are required, you are billed on a per word basis for each additional 
word. For example, a subscriber may be on a plan that has an allocation of 30,000 words monthly. If the 
subscriber uses 31,000 words in a given month, 1,000 words are billed as pay-as-you-go words. Refer to 
the subscription agreement for the pay-as-you-go word rates. 
 
Word overages will be charged in the next billing cycle. You can change your plan to one that includes 
more words, but it will not take effect until next billing cycle. 

What if I don’t need all the words in my subscription this month? 

Words that are not used within the month expire and cannot be rolled over.  You may opt to change to a 
new subscription plan with fewer words. From the Translation Workspace section at GeoWorkz.com, 
click on the Modify Your Subscription and Options dropdown menu and select Change Your Plan.  
The new plan selection will be reflected in your next billing cycle. 

Is fuzziness considered in word metering? 

TM match percentage is not a factor in metering, as only source words in opened segments are counted. 

If one project is translated into more than one language, will the words be 

consumed multiple times? 

Word metering is based on the number of words in the source segment multiplied by the number of target 
languages. If you translate a document into multiple languages, the same words will be consumed as 
many times as there are target languages. 

Licenses 

How do I add licenses to my subscription? 

You can change your subscription at any time to include more licenses. After logging in to 
www.GeoWorkz.com, in the Modify Your Subscription and Options drop-down list, select 
Add/Remove Licenses. Select the number of licenses you want to add to your plan, and continue to 
checkout. Additional licenses are available immediately and are prorated to the end of the month. You can 
add/remove licenses in increments of 1 through 10. Note that the number of additional licenses you select 
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here will replace the number you have currently. If you have 3 additional licenses currently and select 5 
additional licenses, you will now have 5 additional licenses. 
 
Adding or removing additional licenses does not affect your base plan licenses. If you have a base plan 
that includces 10 licenses, and you purchase 5 additional licenses, then replace those 5 additional licenses 
with 3 additional licenses, you still have 10 licenses in your base plan. So in this case you go from 15 total 

licenses to 13 total licenses. 

I’m a Freelancer and I want to add more licenses to my account. How can I do 

this? 

Freelancer accounts cannot have additional licenses added to them. You must upgrade your account to an 
agency or enterprise account in order to have additional licenses. 

How do I remove licenses from my subscription?  

You can remove additional licenses that you have added to your subscription. The maximum number of 
licenses that can be removed is equivalent to the number of additional licenses that you have added. After 
logging in to GeoWorkz.com, in the Modify Your Subscription and Options drop-down list, select 
Add/Remove Licenses. Select the number of additional licenses you want to have in your plan, and 
continue to checkout. For example, if you want to remove all of your additional licenses, you would select 
the top line, $0/Monthly. These changes will take effect on your next monthly billing date. 
 
If you have licenses scheduled to be removed, Translation Workspace will first remove licenses that are 
unassigned. If you have not unassigned a sufficient number of licenses to match the number of licenses 
you have removed, Translaton Workspace will remove (on the billing anniversary date) assigned licenses, 

in order of the longest period of time since they were last used. To ensure no disruption to your users, 
make sure that any additional licenses you want to remove are unassigned before the effective date of 
their removal.  To reduce the number of licenses in your base plan, you would have to change to another 
plan with fewer licenses (using Change Your Plan from the Modify Your Subscription and Options 
drop-down list). 
 

Fixed and Floating Licenses 

An admin can assign ―Fixed‖ licenses to users in the Administration > License Management tab of the 
Translation Workspace Web interface. These Fixed licenses stay assigned to the user until the admin 
manually removes them from the ―Licensed users‖ list. Users that do not have a Fixed license will get a 
―Floating‖ license assigned to them when they login, if there are licenses available. This license will be 
assigned to the user for the duration of their session (plus a 15 minute period after the session ends, 
during which only that user can login again with that license). 
 
If a user logs in, but is denied access because there are no licenses available, they can either wait until a 
license frees up, or their subscriber can purchase additional licenses at http://www.geoworkz.com, which 
become available immediately. Note that the subscription user always has a license assigned, which 
cannot be removed. 

 
Automatic Floating license assignment applies to logins at both http://www.geoworkz.com and Translation 
Workspace (either to translate.translationworkspace.com directly, or from the Translation Workspace 
clients). 
 
The Resources > License Management tab in the Translation Workspace Web interface is where 

admins can manually assign and remove Fixed licenses. The admin can view a list of users without 
licenses, and move them to the list of licensed users. This list indicates whether the licenses are Fixed or 
Floating. It also indicates how many licenses the tenancy has, and how many of these are available at the 
moment. The admin cannot manually remove a Floating license. If the admin wants to free up a Floating 
license, since Floating licenses cannot be manually removed, the admin could see from the list of users 
with licenses which users have Floating licenses, and could tell a user to log out, freeing up the license. 
Alternatively, the admin could inform the GeoWorkz subscriber (who might be the same user) that more 
licenses are needed, and the subscriber user could purchase additional licenses. 

http://www.geoworkz.com/
http://www.geoworkz.com/
http://translate.translationworkspace.com/
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Account 

How do I view my Transaction History? 

You can view your transaction activity in the My Account section of GeoWorkz.com. This Transaction 
History tells you the amount for every transaction, and what has been debited from your credit card or 

PayPal account. 

How do I cancel my account? 

You can cancel your account via a Cancel button in the Translation Workspace tab of at 
GeoWorkz.com. Your cancellation will take effect at the end of your current billing cycle—monthly or 
yearly. When your account is cancelled, your assets will be deleted, and your tenancy deleted, so export 
any assets you need to keep prior to the cancellation date. Annual plans have no cancellation fee.  If you 
are on a monthly plan, you will be subject to a cancellation fee equal to 3 months of your subscription fee.  

How do I change my payment method information? 

If you need to switch to another payment method, choose to edit your payment details from the ―My 
account‖ section of Geoworkz. This change will become effective on your next billing date.  

I received a notice of non-payment. What should I do? 

If a payment fails, you will be informed via email. Possible causes of a failed payment include expired 
credit card, over credit card limit, or cancelled paypal account. If any of the information is incorrect or 
expired, please update. If the payment still cannot be processed, you will receive two additional notices 
informing you of the failed payment attempt. You can always remedy a failed payment by entering valid 
payment information in the My Account area of Geoworkz. Your account must be made current within 10 
days from initial notification or access to your assets will be suspended for all users until the payment is 
made.  

How do I change my GeoWorkz password? 

Translation Workspace and GeoWorkz use the same credentials.  Each user can change their password at 
any time. To change your password in GeoWorkz, login to GeoWorkz.com and click on your My Account 
page.  Click on Edit Account Information.  That will open up the Edit Account page with your account 
details. 

Enter your new password in the Password and Retype Password fields and click the Save button. Your 
password is now updated. 

How do I updgrade my account before my yearly anniversary? 

If you signed up for a yearly plan and want to increase your subscription level immediately, rather than 
waiting for your anniversary date, this must be handled by Customer Support. Please use the Contact Us 
form to initiate the process. 

How do I get a copy of my Invoice? 

GeoWorkz.com is a subscription service, which means that your account is automatically invoiced and 
payment collected. When this occurs, an Account Statement is automatically sent to the email address you 
specified on GeoWorkz.com, in the My Account tab. 
 
The GeoWorkz Account Statement indicates a 0 balance because it reflects payments that have already 
been made, as compared to an Invoice which would indicate an outstanding balance due. The Account 

Statement automatically emailed to you from GeoWorkz.com fully conforms with tax and accounting 
requirements worldwide, and includes: statement date, invoice number, a description of services provided, 
service cost and account balance, GeoWorkz tax address and VAT ID (if applicable), and your billing 
address and VAT ID (if applicable). 
 
If you did not receive this Account Statement or have accidentally deleted it, please submit a support 
request indicating the date and amount of the invoice / payment for which you need the statement resent. 
If you need to update the email address associated with your GeoWorkz.com account, please log in to 

http://www.geoworkz.com/Conctact_Us.aspx
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GeoWorkz.com and then click on your name at the top of the page to go to the My Account tab and edit 
your account information. 
 

GeoWorkz Directory 

How do I create/modify/delete my GeoWorkz Directory listing? 

You can edit your Directory listing information at any time by logging in and going to Directory > My 
Profile and clicking Edit. 
 

Job Posting 

I’m a subscriber. When I apply for a job, why does it ask me questions? 

If you are a Translation Workspace subscriber but not yet a Lionbridge vendor, when you click the Submit 
Bid button, you will be directed through the Lionbridge vendor qualification process. For more information 
on the qualification process, please refer to the ―Want to become a Service Partner?‖ links at 

https://partners.lionbridge.com. 
 
Note: Be sure you have filled out a GeoWorkz Directory profile before applying for a job, as information 
from your profile is automatically used by the Lionbridge vendor qualification process. 

How do I know the status of my applciation to become a Lionbridge Vendor? 

Your Lionbridge Vendor Status is displayed in your Directory Profile. 
 

 
  

Note: Your Lionbridge Vendor Status information is visible only to you. It does not display for those 
viewing your Directory Profile. 
 

The following statuses can be reported: 
 
• Not Yet Applied – You haven’t gone through the vendor application process yet. A link is provided for 
you to do so. 
• Not Yet Reviewed – You have submitted your vendor application, but your application has not been 
reviewed. 

• In Progress – A review of your vendor application is in progress.  
• Application Reviewed. Not Accepted – Your vendor application has been reviewed, but because 
Lionbridge does not currently need someone with your experience and expertise, your application has not 
been accepted.  
• Newcomer – You have completed the vendor application, signed the SLA to the Service Partner Portal, 
and have read the ―Getting Started with Lionbridge Guide.‖ 
• Authorized – You’ve been authorized to work on Lionbridge projects and you have successfully 

completed your first project. 
• Authorized Legacy – You have successfully completed Lionbridge projects in the past. 
 
 
If you haven’t applied to become a Lionbridge supplier, so you can bid on Lionbridge jobs posted to the 
GeoWorkz Marketplace, you can click Click Here to Apply and you will be taken to the Lionbridge portal 

where you can register to be a Lionbridge supplier. 
 

https://partners.lionbridge.com/
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If you are a Free Trial user, when you click to apply, you will get a popup prompting you to upgrade 
immediately to paid plan, so you can become a Lionbridge supplier.  

Back to top 

Connecting to the Translation Workspace Server 

How do I connect to the Translation Workspace? 

Connect to Translation Workspace server at http://translate.translationworkspace.com using a web 
browser. You will be prompted for your username, password, and tenancy, provided to you by your 
GeoWorkz Subscription Manager.  

 
When you connect from the Word Client Plug-in, XLIFF Editor, or the Translation Workspace Tools, you 
must also supply the server address translate.translationworkspace.com. Do not prefix the domain with 
―http://‖ 

My company or Internet Service Provider requires a proxy. How do I connect? 
In rare cases, you might need to enter a proxy address in the login screen. For example, if you are inside 
a corporate network, your connection might be through a proxy server. Your network administrator can 
tell you if you have to use a proxy. Enter the proxy name and the proxy port in the Proxy address field of 
the login dialog of Translation Workspace. Your network administrator will also tell you the proxy port to 
use. For example, if the proxy name is proxy.mycompany.com and the proxy port is 8080, please enter 
proxy.mycompany.com:8080 in the Proxy address field. 

I can’t log in. How do I get help? 
In order to login to GeoWorkz.com or the Translation Workspace, you need a username, a password, and 
a tenancy. If you are a Subscription Manager, you set these credentials during the account creation 
process. If you are a Translation Workspace user, please contact your Subscription Manager. If you have 
forgotten your credentials, use the Forgot Username, Forgot Password, or Forgot Tenancy link(s) on the 
login page. If you are still experiencing issues, please click the Contact Us link at the bottom of any 
GeoWorkz.com page and send us a message describing the problem. 

Before contacting Support, follow these steps to troubleshoot your connection: 
1. Did you connect your computer to the Internet? If not, please connect to the Internet and repeat the 

login. 

2. Did you enter the right server name: translate.translationworkspace.com? 
3. In very rare cases, it might be necessary that you enter a so called proxy address, usually if you are 

inside a corporate network. This never applies when using direct dialup connections to the Internet. 
Your network administrator can tell you if you have to use a proxy. Please enter the proxy name and, 
if necessary, the proxy port in the Proxy address field of the login dialog of Translation Workspace. 
Your network administrator will also tell you the proxy port to use. If the proxy name is 
proxy.mycompany.com and the proxy port is 8080, please enter proxy.mycompany.com:8080 in 
the Proxy address field. 

4. If the issue persists, please ensure that Translation Workspace (.dot and .dll) are ―safe‖ files in your 
Local Firewall Software 

 
Follow these steps to add a proxy server: 
 

http://www.translationworkspace.com/
http://www.geoworkz.com/Conctact_Us.aspx
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Click on LAN settings.... 
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Check Use a proxy server for your LAN. 

Do I need permanent connection to the Internet? 

Translation Workspace is a Live Assets system, designed to give users access to TM, glossaries and review 
packages over the Internet. This has a number of advantages: 

 
 Users don't have to store and manage large translation databases on their local computers. 
 Subscribers can share assets with other subscribers in real time, so additions and changes are 

reflected instantly for any user connected to a shared asset. 
 Translated files can be reviewed online and changes can be reflected instantly 
 Updates to the system are applied automatically to the server-based system components 

 Updates to the translation client applications (Word Plug-in and XLIFF Editor) are pushed 
automatically to users 

 
All users need an Internet connection to access Web-based functionality and server-based assets. Without 
an Internet connection, the following features and functionality will not be available: 
 

 TM and glossary management (import, export, search, statistics) 
 TM and glossary updates 
 TM and glossary access through the Word Plug-in or XLIFF Editor 
 Online review package creation, access and updates 
 User management, role management, license management 
 Reports 
 Client application download 

 Online help 
 GeoWorkz Directory 
 System updates 
 GeoWorkz account access 

What to do if you lose your Internet connection 

If translators and editors temporarily lose Internet connectivity while working in the Word Plug-in or XLIFF 
Editor, the best approach is to wait for it to return before continuing to work. This guarantees that they 
get the latest matches from server-based TMs and glossaries. However, if connectivity is lost for a long 
period of time or during a particularly time-sensitive assignment, users have a options that allow them to 
complete their work and update assets when their connection returns.  
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The following tips and best practices describe how translators working in one of the client applications can 
prepare for loss of Internet connectivity, and how they should work if they lose their connection. 

Working in the Microsoft Word Plug-in 

The Word Plug-in will not allow you perform any functions without an Internet connection, so you will not 
be able to open segments, pre-process or post-process files until your connection returns.  

 
If working on an assignment in the Word Plug-in client, make sure your files are pre-segmented when you 
start work. Your project manager or customer may hand off pre-segmented files, but if not, it is a good 
idea to pre-segment them yourself before you start. This will allow you to continue working through an 
Internet connection outage by simply entering your translations directly into the target section of each 
segment. Again, you will have to work directly on your files in Word without using any of the Translation 

Workspace add-in functions. If you try to use any of the Translation Workspace features, you will be 
prompted to connect to a Workspace server. 
 
When your Internet connection returns, update your server assets by using the ―Clean to Target 
Language‖ feature and make sure the ―Store Translations to TM‖ option is checked in the Document 
cleanup window after you add files to clean. 

 
If you do not have pre-segmented files and are working on a time-sensitive assignment in the Word client, 
you can translate your files by simply overwriting source text, and then post-aligning source and target 
files using a third-party aligner when finished. This is a solution of last resort, as it requires substantial 
additional effort and can result in leverage loss when producing TM from post-alignment. 

Working in the XLIFF Editor 

The XLIFF Editor client will allow you to continue accessing segment open/close features without an 
Internet connection, but no batch functions will be available. You will be able to translate files with limited 
functionality and update your associated TMs after your connection is restored. You can update the TM 
either segment-by-segment (recommended if only a few segments need updating) or by using the ―Add to 
TM‖ batch function and processing entire files. 

Summary 
Working with an Internet connection is required in Translation Workspace. The above suggestions for 
working through Internet connection outages are not intended to be permanent solutions for working 
offline. When working offline, users are not able to contribute to or receive matches from shared project 
assets, impacting the user's individual productivity, the productivity of a virtual team and the quality of 
the working TM for the project in question. Whenever possible, a user should wait for a lost Internet 
connection to return before working in one of the Translation Workspace clients. However, in the case of 
prolonged connection loss, users do have options that insure their ability to stay productive and meet 
project deadlines. 

Back to top 

Translation Workspace Web Interface 

User Management 

How do I create a user in the system? 

As the subscriber or admin user of your tenancy, you can create system (or admin) users who can login 
and work in Translation Workspace. In addition to working within Translation Workspace, these system 
users can authenticate at GeoWorkz.com and access training and other resources there. For details on 
creating users and assigning them roles, see the Guide to Purchasing and Managing a Subscription at the 

Documentation page of the Support area at GeoWorkz.com. Details of Translation Workspace roles are 
given in the Users and Roles topic in the Translation Workspace Web interface help system. 
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How do I assign a license to a user? 

A user must have a license assigned in order to login to Translation Workspace. You assign licenses to 
users in the Administration > License Management tab of Translation Workspace. For details, see the 
Assigning Licenses topic in the Translation Workspace Web interface help system. 
 

Asset Management 

What are Live AssetsTM? 
Your linguistic assets (TMs and glossaries) can be thought of as "live" because they can be updated from 
anywhere at any time by subscribers with access permissions. Updates are instantaneously available to 

all. Based on ground-breaking asset sharing privacy functionality, globally-distributed teams of linguists 
can contribute to and reference centralized assets in real time, introducing key efficiencies into the 
production process. Live Assets are self-maintaining, facilitating process-driven management and 
eliminating costly synchronization work. With near-zero latency and response time measured in 
milliseconds, Live Assets increase speed of work, reduce internal language asset management costs, and 
contribute to lower overall localization spend. 

Does Translation Workspace support TMX? 

Yes. Translation Workspace TMs do support TMX. Translation Workspace supports both TMX 1.1 and 1.4b 
formats. 

How do I change my Translation Workspace password? 

Translation Workspace and GeoWorkz use the same credentials.  Each user can change their password at 
any time. To change your password in Translation Workspace, login to translate.translationworkspace.com 
and click on your user account name link in the top right corner of the page. 

That will open up the Edit User dialog with your account details. 

Type and re-type your new password in the Enter Password and Retype Password fields and click the Save 
button. Your password is now updated. 

How do I set/update attributes of a linguistic asset? 

TM attributes and their values are additional information saved along with translations in a translation 
unit. This information is only saved in the TMs, not in the translated files. Attributes are used to classify 
the translation units inside the TMs, so that during the retrieval of the translations from the TM, some 
translation units can be preferred over others. For details on setting up and using TM attributes, see the 

Translation Memory Attributes topic in the Web interface help system. 
 
An alternative to using TM Attributes to classify the TUs is to use TM Linking.  You can find more 
information on TM Linking in the TM Management training and in the TM Linking topic in the help system. 
 
Glossary attributes are labels that you can add to glossary records. They can provide context or 

background information, translation instructions, semantic and grammatical data, and so on. Attributes 
can be defined either at the language level (across multilingual glossaries) or at global record level (across 
a language). In order to make common tasks easier, such as searching, importing, exporting, and general 
maintenance, you should use the same attributes for all languages. For details on setting up and using TM 
attributes, see the Glossary Attributes topic in the Web interface help system.  
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How do I create an online review task? 

The Translation Workspace Online Review Client is a Web-based application that enables reviewers to 
validate translation using standardized procedures. It provides an administrator’s interface to configure 
the reviewer’s environment. The administrator can use this interface to manage the review packages, 
workgroups, QA models, and so on. 
 

To prepare material for review, you must create packages, which contain the translated files that clients 
are going to review. You create a review package in the Translation Workspace Web interface by selecting 
a Workgroup and then the Review Package… option from the Create New menu. For details, see the 
Online Review topic in the Web interface help system. Also, take the ―Online Review Management ‖ self-
training course, accessed in the Training & Tutorials section of the Support tab of GeoWorkz. 
 

What are Background TMs, premiums, and penalties? 

One of the most powerful and unique features of Translation Workspace is its capability to allow TMs to be 
freely combined and grouped together. This way you can create ―super-TMs‖ from different sources while 
keeping the underlying information strictly separate. Prioritize the highest quality reference material by 
applying a penalty on less reliable or legacy sources.  

 
Every working TM can be associated with any number of background TMs. From the user's point of view, a 
background TM is a read-only TM that cannot be edited directly, but contains additional translations that 
can be leveraged. Technically, background TMs can be reference TMs as well as working TMs for a 
different group of users, so the possibilities of combining TMs are truly endless.  
 

Premiums and penalities increase and lower the priority of a background TM, respectively. When there are 
several translations with similar match values, the Translation Workspace system will suggest the 
translation from the TM with the highest premium or lowest penalty first. 
Premiums and penalties are added to the match value to calculate the match with the highest priority but 
are denoted distinctly in the Translation Workspace Clients. For example, a match value of ―100+2%‖ 
signifies a 100%-match from a TM with a 2% premium. A match value of ―100-2%‖ signifies a 100%-
match from a TM with a 2% penalty. 
 
Penalties are also reflected in word counts. Less reliable fuzzy or full matches will be counted with a lower 
match value. Although premiums could be reflected in word counts, Translation Workspace does not count 
them, as it would be unfair to increase the matching value of a fuzzy just because it is more reliable. 
 

Combining reference TMs 

Multiple reference TMs can be linked to the working TM with different premiums and penalties based on 
the reliability and quality of their content. 
For example: 
 If the reference TM has been fully approved and its translations can be used without review, link it with 

a premium of +1%.  

 If the translations from the reference TM are generally acceptable, but must be reviewed by the 
translator, link it with a penalty value between -5% and -10%.  

 If the reference TM is a deprecated or unapproved version, link it with a penalty of -15%.  
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Combining working TMs 

Multiple working memories can also be linked in the some project. 
 
Different working TMs can represent the different stages of a project (Translation, Review, Validated). In 
this example, the different working TMs may be accessible to different groups of users (translators, 
reviewers, validators). 

 
The Translation Workspace system of premiums and penalties assures that not only all translations are 
available to everyone on the project at any time, but also that the version of a translation from the more 
advanced project stages will override versions from earlier stages.For example: 
 If a second working TM is used at a later project stage, link it with a premium between +1% and 

+10%.  

 If the second working TM is used at an earlier project stage, link it with a penalty between -1% and  

-10%.  

 

 If the working TMs are used to distinguish components or versions, select a value between -5% and  
-10% for each of the TMs.  

 

Why can’t I use the TM Maintenance Editor? 

The TM Maintenance editor requires certain permissions. If you cannot access the editor, your role for the 
TM does not include the requisite object permissions. 

What is the “Unknown Styles or Fonts” email? 

If you import a TM in which there are styles or fonts that are undeclared in the TM header, you will get an 
email like this: 
 
Subject: Translation Workspace TM import uknown styles or fonts 

 

Unknown styles or fonts during import of Sample_TM.txt into database UI_Legacy1: 

unknown_font [13] 

 
This is telling you that there is a font that has not been declared in the header section of the file of the TM 

you are importing. You can use the number in the report (for example, ―13‖ in ―unknown_font [13]‖), to 
find the segment in the file you imported. This can alert you to translations from the TM that are missing 
styles or fonts or that might be corrupted. 
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Sharing Linguistic Assets 

What is Asset AliasingTM? 
Asset Aliasing is the process of sharing linguistic assets between subscribers, without risk. The owner—or 
publisher—maintains control of their linguistic assets and can decide how long other subscribers—or 
recipients—should have access to them. Identities of both the issuers and recipients are protected during 
the aliasing process. 

How do I make my linguistic assets (TMs, glossaries, and review packages) 

available to others? 

Asset Aliasing is the process of sharing linguistic assets between subscribers, without risk. You make your 
linguistic assets available to users in other tenancies by generating an access key (or ―token‖) for the 
asset and sending it to users you want to use the asset. This is called ―publishing‖ the aliased asset. The 
receiver of the token can then ―subscribe‖ to the asset. The receiver of the token can also, in turn, 
generate another access key for the linguistic asset, and can send this second access key to another user. 

In this way, suppliers can share their assets with LSPs, who can then share the assets with translators. 
 
Note that when a translator stores a translation in an aliased TM, the word usage is applied to the tenancy 
of the original asset owner (that is, the publisher) of the TM alias.  
  
Users with sufficient permissions can view lists of published and subscribed assets. These lists contain the 
name of the tenancy that published or subscribed to the asset, but not of the individual user who 
published or subscribed. 
 
For instructions on publishing and subscribing to aliased assets, see the Translation Workspace Web 
interface help system topic on Aliasing Assets. Also, take the ―Asset Aliasing‖ self-training course, 
accessed in the Training & Tutorials section of the Support tab of GeoWorkz. 
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How do I grant/remove access from a linguistic asset? 

Users with sufficient permissions can add and remove users as members of linguistic assets. Select the 
asset in the asset tree, either add the user or select a user who is already a member, then click Remove.  
 
You can control what level of access a member of an asset has via the role that you assign the user. A 
user's role determines her or his permission to perform operations on the asset (for example, read, write, 

export). For details about roles, see the Roles topic in the Web interface help system. Also, take the ―User 
Management‖ self-training course, accessed in the Training & Tutorials section  of the Support tab of 
GeoWorkz. 
 
When you alias an asset for users in other tenancies, you can control what operations they can perform on 
the asset (for example, import, export, connect background TMs to the aliased TM). You can also revoke 
the alias at any time. For details, see the Asset Aliasing topic in the Web interface help system.  Also, 
take the ―Asset Aliasing‖ self-training course, accessed in the Training & Tutorials section of the Support 
tab of GeoWorkz. 

In the case of aliased assets, who gets charged – the issuer or the recipient?  

When an asset is aliased, the original asset owner (that is, the publisher of the alias) is charged for the 

usage of that TM. 
 

As a translator, what access do I have to the TM and glossary data on the 

server? 

Your rights depend on the role you have been assigned for a particular asset or workgroup.  As a 

translator, you will have access to reference all translation assets, including TM segments and glossary 
terminology, that are linked to the active working TM to which you have been given access rights. Opening 
each segment in a translation client will identify where the translation and/or terms are coming from. 
Background assets are accessible to translators for searches and leverage purposes, but not in writing 
mode. 
 

Most asset settings, such as penalty settings, segmentation rules, and colour settings are not accessible to 
translators, but are determined by the asset owner in the server. 

Do translators stay anonymous during the whole translation process with 
Translation Workspace? 

Translators remain anonymous to the publishing tenancy when they are working with aliased assets. The 

segments they store into the source of the aliased TM do not have their user name attached. Only the 
tenancy name is seen. 
             Back to top 

Translation Workspace Clients 

Which translation client should I use? 

If the content you are translating is in markup language format (for example, XML, HTML, MIF, or DOCX), 
the XLIFF Editor is the preferred client. XLIFF is an XML-based format created as an open standard for 
localization, and is being used by more and more enterprises. The XLIFF Editor provides an ideal 

environment for translating tagged formats, having key capabilities such as tag protection, and supports 
standard-compliant segment level metadata like status, comments, and context.  
 
The XLIFF Editor is used to prepare the files for translation, translate the files, check for most obvious 
errors, and convert the files back into their original format. The XLIFF Editor connects to the Translation 
Workspace and to the Live Assets available to the user. 
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Translators accustomed to working with Microsoft Word can also use the Microsoft Word Plug-in. Easy to 
install, with a smaller footprint than other translation solutions, this Translation Workspace Client gives 
translators who are Microsoft Word users a familiar environment that they can start using immediately. 
 
The Microsoft Word Plug-in can also be used to prepare files for translation, translate files, check for most 
obvious errors, and convert files back into their original format. The Word Plug-in connects to the 

Translation Workspace and to the Live Assets available to the user. 

How do I download and install a Translation Workspace client? 

There are two translation clients available: The Microsoft Word Plug-in and the XLIFF Editor. 

 
Whichever translation client you choose, you only need to install it once. When new updates become 

available, you will receive a notification when you login to the Translation Workspace server through your 
client, and the new version will be automatically installed on your system.  
 
You can download the most recent Translation Workspace clients from either the GeoWorkz.com website 
or from the Translation Workspace server. On the GeoWorkz.com website, go to the Download page in 
the Support section. Or, on the Translation Workspace server, go to the Download page off the 
Resources menu in the toolbar at the top. 
 

 
For installation instructions, see the Installation topic in the appropriate help system (Word Plug-in or 
XLIFF Editor). These help systems are available from the Documentation page accessed by clicking the 
Help button in the Resources menu at the top of the Translation Workspace Web interface.  
 

Should batch tasks be run using Translation Workspace Tools or the Translation 
Clients? 

Conversion to the translation formats (RTF/XLIFF) of a quantity of files can be done either in Translation 
Workspace Tools (for RTF or XLIFF formats), or in the XLIFF Editor (for XLIFF formats).   
 
Analysis and Auto Translation batch tasks on XLZ files should be done in the XLIFF Editor.  Analysis and 
Auto Translation batch tasks on RTF files should be done in Translation Workspace Tools.  We do not 
recommend batch processing files in the Microsoft Word Plug-in, as processing files in Microsoft Word 

prevents you from using Microsoft Word during the batch operation. 
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Why is there a discrepancy in word counts between the analysis I ran in the 
Translation Workspace Tools and the XLIFF Editor? 

There can be several reasons for a discrepancy, including a difference in the analysis process used by 
Translation Workspace Tools (which uses the Microsoft Word Plug-in DLL) and the XLIFF Editor (which 

uses its own process).  To remove the impact of these differences, we suggest that you choose the XLIFF 
Editor Batch operations functionality to run your analysis of XLZ files. 

XLIFF Editor 

When I run a spell check, the XLIFF Editor reports that an Exception occurred -
Cannot find proofing tools for X language. How can I resolve this? 

This issue can be resolved by configuring the Xliff Editor to use the correct speller. In the XLIFF Editor, 
select Tools> Spell check Configuration  
 

 
 
In the dialog which appears please select the language. Note that you will need to ensure that this 
language Proofing tools are installed. These can be installed via the MS office installer. 

When I open a segment I see text in red which are just numbers. What are 

these and how can I view them in full context? 

These pieces of Text are Translation Workspace Internal Tags shown in Minimal Content.  
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In order to view the full text show full editor tags must be selected. This can be done in the following 
manner. View >Segment View Tags > Full +ID: 
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Where can I find more help on using the XLIFF Editor? 
The XLIFF Editor includes a help system which you can access from the Help button in the toolbar. You 

can also access this help system from the GeoWorkz.com Support area, and  from the Help item in the 
Resources menu in the toolbar at the top of the Web interface. Also, take the ―Translation Workspace 
Client - XLIFF Editor‖ self-training course, accessed in the Training & Tutorials section of the Support tab 
of GeoWorkz. 
 

Microsoft Word Plug-in 

Does Translation Workspace work with Office 2007 and/or Windows 7? 

The Translation Workspace Microsoft Word Client Plug-in works on Office 2007 and Microsoft Windows 7. 
                                                                                                                                                                                 
The Word Plug-in works under Office 2007, except for the following keyboard shortcuts:: 

 Alt+ Num- (Open next untranslated segment)  
 Alt+ * (Translate to next non-100%-match)  

 
Make sure to enable the 'Visual Basic for Applications' option when installing Office 2007. 
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How do I know whether the Translation Workspace Microsoft Word Client Plug-

in was installed successfully? 

After you have installed the Translation Workspace client, restart Microsoft Word. In Word 2007, you 
should now see the Translation Workspace tab at the top: 
 

 
 
Clicking the Translation Workspace tab displays the Word 2007 ribbon: 
 

 
 
This ribbon contains buttons and menus for performing the commands you will use. 

What should I do if I don't see the tab or ribbon after installing the Microsoft 

Word Plug-in? 

The Translation Workspace template may not be attached to your document or not activated. Go to your 
Tools/Templates and Add-ins menu and make sure the Translation Workspace template is in the list of 
attached templates and is activated. 
 Open Microsoft Word(Office XP, 2003), and go to Tools > Templates and Add-ins. 

 For Microsoft Word 2007 go to the Word Options > Add-Ins > Manage > Word Add-ins  and click 
Go 

 Add the 'WorkspaceforWord.dot' to the Global templates and add-ins list. 
 Ensure the checkbox beside WorkspaceforWord.dot is checked. 
 

 
 
Note (Office XP, 2003 users): If you cannot immediately find the WorkspaceforWord.dot template from 
the default location when using the Add... option, try and locate it in C:\Program Files\Microsoft 
Office\Office\Startup\WorkspaceforWord.dot. If it is there, move it to the default location: C:\Documents 
and Settings\<WIN-USERNAME>\Application Data\Microsoft\Templates, and try adding the template again. 
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Also, ensure that the TradosX.dot template (TRADOS6.dot) is unchecked, so all keystrokes in Microsoft 
Word activate Translation Workspace tasks only. 
 
If you still can't see the Translation Workspace toolbar, there may be a conflict with MS Outlook. 
If you have Outlook opened and you are using Microsoft Word as your e-mail editor, the Translation 
Workspace menu and toolbar will not display in Word at startup. This is due to the fact that Outlook opens 

a hidden Microsoft Word instance. 
To avoid this problem, either: 
• Disable Microsoft Word as your e-mail editor 
• Launch Microsoft Word before opening Outlook 
 
If the template is in the list and activated, but you still can't see the Translation Workspace menu or 
toolbar, you are most likely running a virus scanner which is blocking the Translation Workspace 
functionality. To check this, go to your virus scanner and add the WorkspaceforWord.dot file to your list of 
safe files. After restarting your system and Microsoft Word, you should now see the Translation Workspace 
menu and toolbar. 

What should I do if I see the Translation Workspace menu, but not the toolbar 

in the Microsoft Word Plug-in? 

In this case, the Translation Workspace template is activated, but the toolbar should be made visible in 
the View > Toolbars menu (in Word 2003): 
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Where can I find more help on using the Microsoft Word Plug-in? 
The Microsoft Word Plug-in includes a help system which you can access from the Online Help button in 
the Translation Workspace menu. You can also access this help system from the GeoWorkz.com Support 
area, and from the Help item in the Resources menu in the toolbar at the top of the Web interface. Also, 
take the ―Translation Workspace Client - Microsoft Word Plug-in‖ self-training course, accessed in the 
Training & Tutorials tab of the Support section of GeoWorkz. 

Hotkeys conflicts between Translation Workspace and other CAT Tools 

In some instances Translation Workspace and other CAT Tools use the same Hotkey functionality for core 
translation tasks. Therefore please ensure to deactivate any other CAT Tool’s word templates when using 
Translation Workspace and visa versa. In Word’s Templates and Add-Ins dialog, ensure to deselect all 
other CAT Tool Add-ins. 

 

 

When I attempt to clean some doc or rtf files Translation Workspace reports 
corrupted segments. How can I fix these? 

Typically Translation Workspace reports issues when Translation Workspace tags have been removed or 
added incorrectly to the bilingual file. The best way to identify corrupt segments is to run a QA clean up 
check report. In the report provided by Translation Workspace a list of corrupt segments will be detailed. 
Please check the report for issues and then resolve the issues in the bilingual file. 
 
For example in the screenshot below its possible see that Translation Workspace tags have been altered. 
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When I try to connect to the server from the client, it says "Invalid Translation 

Workspace Client Version.” What should I do? 

Usually when there is a new Translation Workspace client version available for download on the server, it 

is automatically installed at your next connection.  However, there may at times be time that you attempt 
to connect with an old client version installed on your computer. 
 
If your installed version is too old, they automatic synchronized with the current server version will not work, and 

you will get the following error message: "Invalid Translation Workspace Client Version". 
 
You should upgrade your version by following these instructions: 
1. Close Microsoft Word (and MS outlook if Microsoft Word is set as default Editor). 

2. Download the installation file (Download pagetab on the Translation Workspace server). 

As I am closing a file I’ve been translating, it says "Can’t open Clipboard.” 

What should I do? 

If Word crashes while you are working on a file, and if when reopening the file one of the segments was 
activated, you may get an error message "Can't open Clipboard" when attempting to close it. 
 
Go through the steps below in sequential order (only try step 2 if step 1 didn't solve your problem): 
 
1. Connection with the Translation Workspace server may have been lost while your segment was open. 

a. Revert your previous action (if you try to close segment) to restore Translation Workspace 
variables (use edit undo). 

b. Do not use „Close segment, don’t save― or „close segment and delete translation―, but the 

Close and Store, or use any Translation Workspace action (Concordance search, e.g.), that 
triggers a login at the server. 

2. Run the Repair function. 
a. Run the Repair function (Translation Workspace > Current Document > Repair menu) on 

the document with the corrupted segment. 
3. A hidden instance of Microsoft Word may be running. 

a. When Microsoft Word crashes, it sometimes doesn’t kill the whole application and keeps a 
„zombie― Microsoft Word process. This hidden Microsoft Word application is possibly still holding 
an open clipboard handle which generates the error message. 

b. This process is only visible in the Task list. Go to the Process tab in your Windows Task 
Manager and remove all winword.exe processes. 

c. Restart Microsoft Word and try to open a segment. 
4. Translation Workspace Client may be corrupted. 

a. Re-install the Translation Workspace client (possibly the template got corrupted simultaneously 
with the segments). 

b. Restart the system. 
c. Open up Word with an empty document. 
d. Type "This is a test.", and try to open this segment.  
e. What happens now: can you open the segment without problem or do you again get the 

clipboard error message? 
 
Note: This error can be caused by another application which captures the clipboard content. It is 
important to close it, otherwise the error won’t go away. Related to the Error: Another application has 
locked the clipboard section below 

As I am translating, it says "Another application has locked the clipboard.” 

What should I do? 

This error message most often appears when 'GetRight(r) Download Manager' software is installed on 
your machine. 
 
De-activate the application when working with Translation Workspace solves the problem. 
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If you are using a virtual machine, de-activate the clipboard synchronization option under the VM 
additions. 
 
If you are using Parallels Desktop for Mac,  turn off clipboard synchronization via the "Parallels Tools" menu. 

When opening a segment, it says “missing set source.” What should I do? 

When trying to open a segment, if you get the error message "missing set source" the connection to the 
Translation Workspace server has probably been interrupted at some point or something else corrupted 
the Translation Workspace segmentation. When opening a segment, Translation Workspace creates 
bookmarks to identify source text, translated text and the whole segment. These bookmarks or some of 
the segment information (for example, source text) are actually missing so that the segment can't be 
opened. 
 
To correct the issue you need to remove all the remaining Translation Workspace bookmarks from the file. 
Go to the Insert > Bookmark menu in Microsoft Word to open the Bookmark dialog. 

 

 
 
Remove all the bookmarks named LPBM91_Orig, LPBM91_Segment, LPBM91_Trans. 
Now you should be able to open a segment. 

Online Review Client 
How do I access the Online Review Client? 
You launch the Online Review Client from the Online Review button in the toolbar at the top of the 
Translation Workspace Web interface. This brings up the Online Review Client in the browser. Select the 
review package on the left, then the individual file you want to review from the Files display on the 
bottom.  

 
Where can I find help on using the Online Review Client? 
For details on using the Online Review Client, see the Online Review Client help system, which you can 
access from the Documentation page via the Resources menu at the top of the Translation Workspace 
Web interface. Also, take the ―Translation Workspace Client - Online Review‖ self-training course, 
accessed in the Training & Tutorials section of the Support tab of GeoWorkz. 
 

Translation Workspace Tools 

What is the ML Assistant, and how do I use it? 

The Markup Language Assistant provides an intuitive and interactive way for you to identify localizable 
content within a tagged file such as XML, HTML, or SGML. The "parsing rules" are stored as a "Profile" in a 
configuration file. This file is saved in XML format, which advanced users can also create or manually 
update in a text or XML Editor. 
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The Markup Language Assistant allows advanced users to benefit from the power of XPath expressions. 
The ML Assistant also allows you to define XPath expressions with conditional parsing rules based on 
attribute values for HTML and XML files. 
 
For details on using the Markup Assistant, see the Markup Language Assistant Dialog topic in the the help 
system for the Translation Workspace Tools or the Microsoft Word Plug-in. Also, take the ―Translation 

Workspace Tools‖ or (for a more advanced course) the ―Advanced ML Assistant‖ self-training course, 
accessed in the Training & Tutorials section of the Support tab of GeoWorkz. 

What is a word count analysis? 

A word count analysis is a report on the amount of leverage you get for a document from the selected TM 
or TM set. This report can include leverage information for each match type, as well as the name of the TM 
(foreground or background) that provides the match. 

Can I perform an analysis to generate word counts? 

Every user can generate word counts on the Translation Workspace server. Because word count analyses 
is a CPU-intensive operation, you should use discretion when running it. 
 

Rules regarding the use of the word count function: 

 Use to Send Analysis Result as Email option for best results. You will receive your analysis results 
by mail as soon as the server has processed them. The Word client plug-in reserves Microsoft Word for 
the time that it is processing the analysis on the server, but the email option frees Microsoft Word as 
soon as the data inside the files is sent to the server. 

 Be aware that analyses for accounting purposes should always run on the whole project and are likely 

to generate somewhat higher leveraging than what you will see on a partial analysis of individual 
batches. 

 Always activate the Use Analysis TM/Delete Analysis TM option to get optimal (fuzzy matching) 
leveraging results from the shared TM. 

 

What tool do I use to perform word count analysis for supported file types? 

Analysis can be conducted using the Translation Workspace Tools, Microsoft Word Plug-in, or XLIFF Editor.  
Access the Document Analysis dialog from Analyze at Start > All Programs > Translation 
Workspace > Tools > Translation Workspace Tools. In the Word Client, Plug-in, select Current 
Document > Analyze or Documents > Analyze. In the XLIFF Editor, use the Analyze tab in the Batch 
Operations dialog off the TM menu. For details, see the help system for the Translation Workspace Tools 
or for the client you are using.  

When I analyze my project files, the results show only repetitions. 

This happens when the Analysis TM created during a previous analysis wasn't deleted. 
Delete the Analysis TM before analyzing the files by selecting the Clear Analysis TM checkbox from the 
Analyze tab/dialog. 

How does Translation Workspace count words? 

The analysis result reports only categories of fuzzy matches. While translating, the exact match percent is 
displayed instead. 

Translation Workspace analysis results will keep the matches in industry standard categories, but inside 
the matching categories there can be variation. The variation inside categories is largest when the matches 

are below 75% matches. 

You can adjust the minimum match percent setting in the Microsoft Word Plug-in by selecting Translation 
Workspace Settings > Configure Client and entering a number in the match percent field. You can also 
freely adjust the minimum match percentage of the concordance search. These settings are user specific, 
and have no effect to how Translation Workspace works for other users. 



February 1, 2013           Copyright © 2013 GeoWorkz, Inc.   25 
 

 

Does the order in which files are analyzed affect the word count? 

The weighted word count of each individual file depends on the order in which the files are analyzed. The 
latest analysis files will leverage from the content of all the previously analyzed files, both for repetitions 

and internal fuzzy matches. 

How can I check what word count options have been run? 

You can verify the settings used when Document Analysis was run by looking in the header of the XML log 
file. Check this line: 
 
<Analysis Date="20080213T154444Z" AnalysisID="642738" CATTool="Translation Workspace" 
ATM="yes" ClearATM="yes" IgnoreTrans="no"> 
Where: 
•  ATM = Use Analysis TM 
•  ClearATM = Clear Analysis TM 
•  IgnoreTrans = Ignore existing translations 

 
These settings correspond to the following option settings in the Analyse tab for a selected TM in the Web 
interface: 
 

  
 
Note that this information exists in the XML file, but is not displayed in the browser view. It also isn’t 
included in the plain-text and HTML version of the word count log. 
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How do Translation Workspace and industry standard analysis categories  

compare? 

To see how Translation Workspace word counts compare with those of other industry standard translation 
tools, see the Guide to Migration and Interoperability (accessible from the Guide to Migrating Linguistic 
Assets link in the Documentation page on this Support site). 

In the word count analysis dialog, what does "Ignore Existing Translations" 

do? 

Selecting "Ignore Existing Translations" allows word counting of the file in a normal way, excluding any 
content in the file which has already been translated. 

What are format changes? 

Format changes are things like tag differences, case differences, and punctuation differences. Segments 
with only format differences are considered as 95-99% matches. They are 100% matches with differing 
formats. 

Can the penalty for differing formatting be set to zero for ML file types? 

Yes. The format penalty can be set to zero. Do this in the Penalty for different formattting setting in 
TM > Properties > Advanced tab in the Translation Workspace Web interface.  
 

Back to top 

Translating 

Supported Formats 

Can I translate PPTX and XLSX files directly in Translation Workspace? 

Yes, PowerPoint and Excel files can be translated in Translation Workspace. These need to be converted to 
XLZ or RTF format for translation. See the Word Client Plug-in or the Translation Workspace Tools help 
systems for the conversion steps. For other details, see the Filters and File Formats Guide. 

I get a “Format Detection” dialog when opening a segment. What should I do? 

When I try to open the first segment in a new file, the following ―Format Detection‖ dialog appears: 
―If seems as if this document contains formatting and tagging of segments in an external style. We have 
to convert these styles to proceed.‖ 
 

 
 
This dialog indicates that the file you're trying to translate has been prepared for Trados™, Wordfast, or 
some other translation tool, but not for Translation Workspace. Although Translation Workspace can 
recognise Trados™ styles, it requires its own styles for translation. 
 
Click Cancel. Then convert the file using the Change Tagging to Translation Workspace Format 
option from the Current document menu (or the same option from the Documents menu if you want to 

convert a batch of files). 
 

https://staging.geoworkz.com/help/PDFs/Guide_to_Migrating_Linguistic_Assets.pdf
https://staging.geoworkz.com/help/PDFs/Guide_to_Migrating_Linguistic_Assets.pdf
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Best Practices 

What is the best practice for dealing with draft translations? 

With Asset Aliasing, there will often be multiple translators sharing a TM, so segments translated by one 
translator are immediately available to be recycled by other translators. Leaving "first draft segments" in 

the TM for a long time can create two types of issues: 
 Increased risk of spreading mistakes 
 Extra work for other translators who see "draft segments" proposed as fuzzy or 100% matches 
 

Suggested solution 1: Changing the review process 

Rather than doing a first draft translation and then proofreading the work after completing all the files 
allocated, translators should review their work and run the spellchecker at least twice a day then update 
the draft segments in the TM with these proofread segments. This reduces the time a draft segment stays 
in the TM, therefore, the chance of it being reused is relatively low. 
 
Advantages of storing draft segments: Translators can leverage from their own work done in the 
translation "session". 
Disadvantages of storing draft segments: Draft segments entered in a TM even for a very short time 

results in a risk of being reused. 
 

Suggested solution 2: Don't store segment in memory 

A translator unsure about the translation of a segment should not enter it into the TM. Instead, use the 
Close segment, don’t save feature which lets Translation Workspace users save the segment for later 
review, without storing it to the TM.  

 
Advantages of not storing draft segments: There is no risk of draft segments being reused. 
Disadvantages of not storing draft segments: Translators cannot leverage from their own work done 
in the current translation "session". 
 

Suggested solution 3: Mark the translation as tentative 

If translators cannot find a satisfactory solution, they should enter a query and mark the queried term 
with a query marker (for example, +++ or /// or ***, or any other marker that you normally use or agree 
on). If the term is marked, the segment can be entered in the TM because the query marker will indicate 
that the translation is tentative. 
 
Advantages of storing tentative segments: Translators can leverage from their own work done in the 
translation "session". 
Disadvantages of storing tentative segments: Leveraged segments include the query marker, which, 
if not agreed to by all parties using the asset, may be confusing. 

My client provided me with TTX files file for translation. How can I use the 

XLIFF Editor to translate these files? 

The XLIFF Editor has a filter to convert TTX files to XLIFF for translation via the XLIFF Editor. In order to 
open these TTX files in the XLIFF Editor follow these steps: 

1) In the XLIFF Editor, click File > Open.  
2) In the dialog which appears select to view "All files".  
3) Browse to the TTX files and open.  
4) The Setup TTX to XLIFF Conversion dialog will convert these files to XLIFF for translation via the 

XLIFF Editor. 
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Chat Functionality 

What is the Chat Function? 

The Chat function allows all collaborators on a project, within the same tenancy, to have quick and direct 
communication. For example, collaborators can query terminology or check why a certain translator or 

proofreader decided on a particular translation. 
 
Despite being a great help in bringing a remote team closer together, the Chat function can also be quite 
disruptive if not used with consideration. 
Consider these guidelines when using chat: 
 Only use the chat to discuss project-specific topics, not for personal communications or social 

announcements. 
 Direct your chat messages only to the people directly involved. 

How can I check if my entire file has been fully translated? 

This can be checked via Translation Workspace QA tools . Go to Start > All Programs > Translation 
Workspace > Translation Workspace Tools > QA tools. In the Quality Assurance Tools dialog 

select the Omission check box and run the check on your files. Translation Workspace will provide a 
report which can be reviewed to ensure all segments are translated. 

I’ve finished translating my files and reopen them in Word. Why do I only see 

the localized segments and no source segments? 

After opening a localised file the user can only see the Target segments as in screenshot below. 

 

 
 
In order to view both source and target strings all formatting marks must be active in the word client In 

order to do this the user should select the Formatting option as below. 
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How do I add my translations to the TM? 

There are two ways to save translations to the TM.  Translation Workspace, with Live Assets, is designed 
to have translations automatically saved to the TM during translation.  In order to save translations 
automatically, you simply need to translate and use any of the functions that include Store. 
There is also the option to clean the bilingual file to target after translation is done.  This can be done in 
both clients and in a batch function.  For more information on this function, please refer to the relevant 
documentation. 

How can I check if all my files will clean correctly? 

This can be checked via Translation Workspace QA tools. Go to Start > All Programs > Translation 
Workspace > Translation Workspace Tools > QA tools. In the Quality Assurance Tools dialog 
select the Cleanup check box and run the check on your files. Translation Workspace will provide a report 

which can be reviewed to ensure all files will clean correctly. 

How can I modify a locked segment? 

Locked segments can be modified in the Word Client Plug-in. The steps to do this are to select the 
segment and go Current Document > Unlock Current Segment. 
 

In the XLIFF Editor, you can control whether a segment can be translated by checking or clearing the 
translate checkbox at the bottom of the segment editor. 

Every time I open a segment the Terminology window appears. How can I stop 
this occurring? 

This functionality can be changed in the Client Configuration dialog. To access this dialog from the Word 

Client Plug-in go Settings > Configure Client. The following dialog will appear. In this dialog de-select 
―Terminology Window Always on Top.‖   
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How do I restore unclean files after I’ve cleaned them? 

During the clean-up process Translation Workspace creates a *.bak file which can be renamed to the 
original file name to restore the unclean file, if you have selected the Create .Bak Copiesbak copies of 

Input Filesinput files option on the Translation Workspace Document Cleanup dialog 

  
 

Does Translation Workspace find multiple fuzzy matches? 

Yes, Translation Workspace always suggests the highest match first, but you can navigate between all 
available matches by using the Get Next Match and Get Previous Match features. 
These features are accessible from the Translation WorkspaceTranslation ribbon directly, and from the 
Translation menu: 
 

 
 
or from the Translation Workspace ribbon: 
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What is the difference between “Open next non-100% match”, “Open next un-

translated segment” and “Translate to next non-100%-match”? 

A brief description of each of the functions are available below. 
 

Open next untranslated segment 

This opens the next segment (from the current cursor position) that is still untranslated. You can use it to 
check whether any text was left unsegmented or untranslated in your document. 
 

Open next non-100% match 

This opens the next segment (from the current cursor position) that is not an exact match. This function is 
affected by the TM Settings in the Translation Workspace web interface. If the Include Only Context 

Matches in Batch Translations option is enabled, only 101% matches are skipped. The function will 
stop on 100% matches. If the option is disabled, the function will skip both 100% and 101% matches. 
This function should be used when you want to review segments for which you don't get an exact match 
during interactive translation. It can also be used by proofreaders to locate translations that were newly 
added during the project. 
 

Translate to next non-100% match 

This translates all segments beginning with the current cursor position for which the TM offers a unique 
100% match. Segmented and unsegmented strings are checked against the TM. If a unique exact match 
exists, the string is autotranslated and Translation Workspace moves to the next segment. If no match 
exists in the TM, the function stops. The segment with a non-100%-match is then opened. 
 
This function is affected by the TM Settings  in the Translation Workspace Web interface. If the Include 
Only Context Matches in Batch Translations option is enabled, only 101% matches are translated. 
The function will stop on 100% matches. If the option is disabled, the function will translate both 100% 
and 101% matches. 
 
This function can be used when you want to update the document with latest TM content. 

Match Rates 

How are different level matches prioritized? 

The prioritization in which matches are presented is as follows: 
 
1. 101% match according to most recent date 
2. 100% match according to most recent date 
3. Fuzzy matches according to matching percentage and date 
 

Penalties or Premiums applied on linked TMs can interact for all matches. For example, a 101% in a linked 
project with a penalty of –1% will appear as a 101-1% match, which is equivalent to a 100% match in 

terms of priority ordering.  A 95% match in a linked TM with a premium of 3% will appear as a 95+3% 
match, which is equivalent to a 98% match in terms of priority ordering. 

Context Matching 

What is context matching? 

Context matching is an advanced technology featured in Translation Workspace that allows it to store a 
translation along with the specific textual context in which the segment occurs in the TM.  
Context information allows for highly accurate re-translation of unchanged passages in an updated 
document, for instance. This option allows you to re-create the translation of a document with a very high 
level of accuracy at a later time. Short, ambiguous sentences that usually require a different translation at 
different points in the text can easily be identified by taking their respective context into account.  
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A context match is identified as a 101% match in a translation client, as well as in the word count 
analysis. 
 
Context matches can be enabled or disabled for each project.  
 
Context matches have a high level of accuracy so your productivity to review them will increase. Given the 

higher reliability of these matches, on some projects you may even not be requested to review them. 
As a context match (101%) has a higher priority than an exact match (100%), it will always be proposed 
first to the translator. 
Be aware that the use of context matching has some particular consequences: 
 Even if one instance of a particular segment is modified and saved to the TM, several other 

(unchanged) translations may still reside in the memory, if that same segment occurred in multiple 
contexts (locations). 

 The translator may not necessarily get the updated translation from the TM as the first suggestion, if an in-
context match already exists in the TM. 

 An older 101% match will have priority over a more recent 100% match. This means that if you 
correct a segment that appears several times in a document, but are using a TM made from the 
previous version of this document, you will NOT get your correction as first choice segment if there is a 
101% match in the TM. 

Fuzzy Matches in an Empty TM 

How can you have fuzzy matches against an empty TM? 

Performing a word count in Translation Workspace using the Use Analysis TM option will almost always 

include fuzzy matches, as Translation Workspace not only analyzes the source files against the available 
TM, but it will also look for fuzzy matches in the source files themselves. In other words, it will look for 
similar, recurring sentences in the source material. It will do so by building up an "Analysis TM" during the 
word count process. Fuzzy matches can then occur within one file or between multiple files. 
 
In fact, this process is a more accurate representation of what the translator will encounter as the TM is 
being built up during the translation phase. 

 
For example, suppose the following three sentences occur in your source document: 
 

1. Click the Start button to initiate the process. 
2. Click the Print button to initiate the process. 
3. Click the Start button to initiate the process. 

 
Translation Workspace will count these as, in order: no match, fuzzy match, and repetition. 

How can I ensure that Translation Workspace matches Trados segmentation? 

The Translation Workspace segmentation engine is very similar, but not exactly the same as the one in 
Trados. Typically you won't encounter any issues due to different segmentation. However, if you want to 

be fully compatible with the Trados segmentation, you can always pre-segment your files using the Trados 
option Segment Unknown Sentences. For an in-depth comparision of Translation Workspace and 
Trados features, see the Guide to Migration and Interoperability, accessed via the ―Guide to Migrating 
Linguistic Assets‖ link on the Documentation page of the GeoWorkz Support area.  

 
Back to top 
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Interoperability 

When creating a Translation Memory (TM) from non-Translation Workspace 

legacy data, is it better to use a TM export or to use bilingual files to populate 

the TM? 

Either method stores your translated segments into the Translation Workspace TM, however if you have 

the bilingual source files, we do recommend using them to create the TM.  By converting legacy bilingual 
content into the TW format and cleaning it into the TM you populate the TM with 101% matches, resulting 
in maximum leverage/translation quality.  If you create the TM by importing a legacy TM file, you lose the 
context of the file and thus cannot get 101% matches on these segments. 
 

Back to top 


